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Introduction

Welcome to the wonderful world of Microsoft 365 apps, formerly known as Microsoft Office! This Step by Step book has been designed to make it easy for you to learn about key aspects of four of the Microsoft 365 apps: Word, Excel, PowerPoint, and Outlook. In each part of this book, you can start from the beginning and then build your skills as you learn to perform increasingly specialized procedures. Or, if you prefer, you can jump in wherever you need guidance for performing tasks. The how-to steps are delivered crisply and concisely—just the facts. You’ll also find informative graphics that support the instructional content.


Who this book is for

Microsoft Office Step by Step is designed for use as a learning and reference resource by home and business users of Microsoft Office 365 or the individual Office apps who want to use Word, Excel, and PowerPoint to create and edit files, and Outlook to organize email, contact information, and calendar items. The content of the book is designed to be useful for people who have previously used earlier versions of the apps and for people who are discovering the apps for the first time.



The Step by Step approach

This book’s coverage is divided into parts. Part 1 introduces the Microsoft 365 apps and the skills that are common to all of them. Parts 2–5 each provide a thorough introduction to one of the four apps covered in this book. Each part is divided into chapters representing skill set areas, and each chapter is divided into topics that group related skills. Each topic includes expository information followed by generic procedures. At the end of the chapter, you’ll find a series of practice tasks you can complete on your own by using the skills taught in the chapter. You can use the practice files available from this book’s website to work through the practice tasks, or you can use your own files.



Features and conventions

This book has been designed to lead you step by step through tasks you’re likely to want to perform in Word, Excel, PowerPoint, and Outlook. The topics are all self-contained, so you can start at the beginning and work your way through all the procedures or reference them independently. If you have worked with previous versions of the apps, or if you complete all the exercises and later need help remembering how to perform a procedure, the following features of this book will help you locate specific information:


	Detailed table of contents Browse the listing of the topics, sections, and sidebars within each chapter.


	Chapter thumb tabs and running heads Identify the pages of each chapter by the thumb tabs on the book’s open fore edge. Find a specific chapter by number or title by looking at the running heads at the top of even-numbered (verso) pages.


	Topic-specific running heads Within a chapter, quickly locate the topic you want by looking at the running heads at the top of odd-numbered (recto) pages.


	Practice tasks page tabs Easily locate the practice tasks at the end of each chapter by looking for the full-page stripe on the book’s fore edge.


	Detailed index Look up coverage of specific tasks and features in the index at the back of the book.




You can save time when reading this book by understanding how the Step by Step series provides procedural instructions and auxiliary information and identifies on-screen and physical elements that you interact with. The following table lists content formatting conventions used in this book.





	Convention

	Meaning






	TIP

	This reader aid provides a helpful hint or shortcut to simplify a task.




	IMPORTANT

	This reader aid alerts you to a common problem or provides information necessary to successfully complete a procedure.




	SEE ALSO

	This reader aid directs you to more information about a topic in this book or elsewhere.




	1. Numbered steps

2.

3.

	Numbered steps guide you through generic procedures in each topic and through hands-on practice tasks at the end of each chapter.




	
	Bulleted lists




	Bulleted lists indicate single-step procedures and sets of multiple alternative procedures.




	Interface objects

	In procedures and practice tasks, semibold black text indicates on-screen elements that you should select (click or tap).




	User input

	Light semibold formatting identifies specific information that you should enter when completing procedures or practice tasks.




	Keyboard shortcuts

	A plus sign between two keys indicates that you must select those keys at the same time. For example, “press Ctrl+P” directs you to hold down the Ctrl key while you press the P key.




	Emphasis and URLs

	In expository text, italic formatting identifies web addresses and words or phrases we want to emphasize.









Download the practice files

Before you can complete the practice tasks in this book, you must download the book’s practice files to your computer from MicrosoftPressStore.com/MSOfficeSBS365/downloads. Follow the instructions on the webpage.


[image: images] Important

Word, Excel, PowerPoint, Outlook, and other Microsoft 365 apps are not available from the book’s website. You should install the apps before working through the procedures and practice tasks in this book.



You can open the files that are supplied for the practice tasks and save the finished versions of each file. If you want to repeat practice tasks later, you can download the original practice files again.


[image: images] See Also

For information about opening and saving files, see “Open and move around in files” and “Save and close files” in Chapter 2, “Create and manage files.”



The following table lists the files available for use while working through the practice tasks in this book.





	Chapter

	Folder

	File






	Part 1: Microsoft Office (Microsoft 365 Apps)




	1: Explore Office

	Office365SBS\Ch01

	None




	2: Create and manage files

	Office365SBS\Ch02

	DisplayProperties.xlsx

DisplayViews.pptx

NavigateFiles.docx




	Part 2: Microsoft Word




	3: Modify the structure and appearance of text

	Office365SBS\Ch03

	ApplyStyles.docx

ChangeTheme.docx

CreateLists.docx

FormatCharacters.docx

FormatParagraphs.docx

StructureContent.docx




	4: Collaborate on documents

	Office365SBS\Ch04

	ControlChanges.docx

MergeDocs1.docx

MergeDocs2.docx

ReviewComments.docx

TrackChanges.docx




	5: Merge data with documents and labels

	Office365SBS\Ch05

	CreateEnvelopes.docx

CustomerList.csv

CustomerList.xlsx

InsertFields.docx

PolicyholdersList.xlsx

RefineData.docx

StartMerge.docx




	Part 3: Microsoft Excel




	6: Perform calculations on data

	Office365SBS\Ch06

	AuditFormulas.xlsx

BuildFormulas.xlsx

CreateArrayFormulas.xlsx

CreateConditonalFormulas.xlsx

NameRanges.xlsx

SetIterativeOptions.xlsx




	7: Manage worksheet data

	Office365SBS\Ch07

	FilterData.xlsx

SummarizeValues.xlsx

ValidateData.xlsx




	8: Reorder and summarize data

	Office365SBS\Ch08

	CustomSortData.xlsx

OutlineData.xlsx

SortData.xlsx




	9: Analyze alternative data sets

	Office365SBS\Ch09

	CreateScenarios.xlsx

DefineDataTables.xlsx

PerformGoalSeekAnalysis.xlsx




	Part 4: Microsoft PowerPoint




	10: Create and manage slides

	Office365SBS\Ch10

	AddRemoveSlides.pptx

ApplyThemes.pptx

ChangeBackgrounds.pptx

CreateSections.pptx

ImportOutline.docx

RearrangeSlides.pptx

ReuseSlides.pptx




	11: Insert and manage simple graphics

	Office365SBS\Ch11

	AccreditPictures.pptx

Bouquets.jpg

DrawShapes.pptx

EditPictures.pptx

InsertIcons.pptx

InsertPictures.pptx

InsertScreens.pptx

Penguins01.jpg

Penguins02.jpg

PinkFlowers.jpg

PurpleFlowers.jpg

RedTree.jpg

Tiger01.jpg

Tiger02.jpg

WhiteFlower.jpg




	12: Add sound and movement to slides

	Office365SBS\Ch12

	AddAudio.pptx

AddVideo.pptx

AnimateSlides.pptx

Butterfly.wmv

CustomizeAnimation.pptx

SoundTrack.wma

Wildlife.wmv




	Part 5: Microsoft Outlook




	13: Send and receive email messages

	Office365SBS\Ch13

	AttachFiles.docx




	14: Organize your Inbox

	Office365SBS\Ch14

	None




	15: Manage scheduling

	Office365SBS\Ch15

	None









E-book edition

If you’re reading the e-book edition of this book, you can do the following:


	Search the full text


	Print


	Copy and paste




You can purchase and download the e-book edition from the Microsoft Press Store at MicrosoftPressStore.com/MSOfficeSBS365/detail.



Get support and give feedback

We’ve made every effort to ensure the accuracy of this book and its companion content. We welcome your feedback.


Errata and support

If you discover an error, please submit it to us at MicrosoftPressStore.com/MSOfficeSBS365/errata. We’ll investigate all reported issues, update downloadable content if appropriate, and incorporate necessary changes into future editions of this book.

For additional book support and information, please visit MicrosoftPressStore.com/Support.

For assistance with Microsoft software and hardware, visit the Microsoft Support site at support.microsoft.com.



Stay in touch

Let’s keep the conversation going! We’re on Twitter at twitter.com/MicrosoftPress.
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1

Explore Office

In this chapter


	Work in the Office user interface


	Discover new features


	Change Office and app options


	Display and customize the Quick Access Toolbar


	Customize the ribbon


	Get help and provide feedback




The Microsoft Office suite of apps (also called Microsoft 365 apps) includes many apps that serve different purposes but are designed to work together to maximize efficiency.

The elements that control the appearance of an app and the way you interact with it are collectively referred to as the user interface. Some user interface elements, such as the color scheme, are cosmetic. Others, such as toolbars, menus, and buttons, are functional. Each app has standard settings based on the way that most people work with the app. You can modify cosmetic and functional user interface elements in each app to suit your preferences and working style.

The Office apps share many common user-interface elements and functions. The ways in which you perform tasks such as opening, saving, searching, printing, and sharing files are standardized across the apps so that you can concentrate your learning efforts on the skills and features specific to the app or to the document, workbook, or presentation you’re creating.

This chapter guides you through procedures common to Word, Excel, PowerPoint, and some aspects of Outlook. It includes procedures related to working in the Office user interface, changing options for Office and for specific apps, customizing the Quick Access Toolbar and ribbon, getting help, and sending feedback to the Microsoft Office team.


Work in the Office user interface

The goal of the Office working environment is to make working with Office files, including Word documents, Excel workbooks, PowerPoint presentations, and Outlook email messages, as intuitive as possible.

On a Windows computer, you can start an app from the Start menu app list or tile area, the Start screen, or the taskbar search box. You might also have shortcuts to apps on your desktop or on the Windows taskbar.

When you start Word, Excel, or PowerPoint without opening a specific file, the app Home page appears. The Home page is a hybrid of the Open and New pages of the Backstage view. It displays links to pinned and recent files in the left pane, and new file templates in the right pane.


[image: The Home page of the Backstage view that appears when PowerPoint starts without opening a specific file. In the left pane are links to the Home, New, Open, Account, and Feedback pages and to the Options dialog. Suggested templates including Blank Presentation appear at the top of the right pane followed by a Search box. Recent, Pinned, and Shared With Me tab headings provide a way to filter the presentation list that follows.]

The Home page presents a simple view of the options available when there is no open presentation




[image: Images] Tip

The size of the Home, New, and Open page tabs in the left pane of the Backstage view changes based on the available space. At some screen resolutions and window sizes, these page tabs are short and labeled only with their names.




[image: Images] Tip

You can suppress the Home page (also called the Start screen) if you want to go directly to a new, blank file when you start an app. For more information, see “Change Office and app options” later in this chapter.



When you’re working with a file, the app window contains all the tools you need to add and format content.


[image: Images]

Elements specific to all Office app windows




Identify app window elements

A typical Office app window contains the elements described in this section. It might also display optional elements such as rulers, gridlines, navigation panes, and tool panes. Commands for tasks you perform often are readily available, and even those you might use infrequently are easy to find.


Title bar

At the top of the app window, this bar displays the name of the active file and provides tools for managing the app window and content. If the file is stored online in OneDrive or SharePoint, a dropdown menu adjacent to the file name provides a simple way to change the file name and access the storage location and version history.


[image: Images]

The title bar elements differ based on the file storage location





The ribbon of commands

Below the title bar, all the commands for working with an Office file are gathered together in this central location so that you can work efficiently with the app. Across the top of the ribbon is a set of named tabs. Each tab displays named groups of commands.


	Standard ribbon tabs The Home tab, which is active by default, contains the most frequently used commands for each app. Other tabs contain commands specific to the type of action you want to perform, such as Insert, Draw, and Design.


[image: Images]

Elements of the ribbon




[image: Images] Tip

Your ribbon might look different from those shown in this book. You might have installed programs that add their own tabs to the ribbon, or your screen settings might be different. For more information, see “Customize the ribbon” later in this chapter.




	Object-specific tool tabs When a graphic element such as a picture, table, or chart is selected in a document, one or more tool tabs appear on which commands related to that specific object are located. Tool tabs are available only when the relevant object is selected. They are differentiated from the standard tabs by name and color, and are always located to the right of the standard tabs.


[image: The Table Design tool tab. The tool tab name is green whereas the standard tab names are black.]

A typical tool tab







[image: Images] Tip

Some older commands no longer appear as buttons on the ribbon but are still available in the app. You can make these commands available by adding them to the Quick Access Toolbar or the ribbon. For more information, see “Display and Customize the Quick Access Toolbar” and “Customize the ribbon” later in this chapter.



On each tab, buttons representing commands are organized into named groups. You can point to any button to display a ScreenTip with the command name, its keyboard shortcut (if it has one), and a description of its function.


[image: Pointing at the Sum command to display a ScreenTip that contains its name (Sum), keyboard shortcut (Alt+Equal Sign), and description (Automatically add it up. Your Total will appear after the selected cells.).]

ScreenTips provide helpful information about commands




[image: Images] Tip

You can control the display of ScreenTips and of feature descriptions in ScreenTips. For more information, see “Change Office and app options” later in this chapter.



Some buttons include an arrow, which might be integrated with or separate from the button. To determine whether a button and its arrow are integrated, point to the button to activate it. If both the button and its arrow are shaded, selecting the button displays options for refining the action of the button. If only the button or arrow is shaded when you point to it, selecting the button carries out its default action or applies the current default formatting. Selecting the arrow and then an action carries out the action. Selecting the arrow and then a formatting option applies the formatting and sets it as the default for the button.


[image: Pointing at two buttons in the Cells group: the Insert button with a separate arrow and the Format button with an integrated arrow.]

Buttons with separate and integrated arrows



When a formatting option includes several choices, they are often displayed in a gallery of images, called thumbnails, that provide a visual representation of each choice. When you point to a thumbnail in a gallery, the Live Preview feature shows you what the active content will look like if you select the thumbnail to apply the associated formatting. When a gallery contains more thumbnails than can be shown in the available ribbon space, you can display more content by selecting one of the scroll arrows or the More button located on the right edge of the gallery.


[image: Images]

You can scroll gallery content or expand it as a pane



Related but less common commands are not represented as buttons in a group. Instead, they’re available in a dialog or pane, which you display by selecting the dialog launcher located in the lower-right corner of the group.


[image: Images] Tip

To the right of the groups on the ribbon is the Ribbon Display Options button, which is shaped like a chevron. For more information, see “Work with the ribbon and status bar,” later in this topic.





The Backstage view of an app

Commands related to managing the app and files (rather than file content) are gathered together in the Backstage view, which you display by selecting the File tab located at the left end of the ribbon. Commands available in the Backstage view are organized on named pages, which you display by selecting the page tabs in the left pane. You redisplay the document and the ribbon by selecting the Back arrow located above the page tabs.


[image: The Info page of the Backstage view of Word.]

You manage files and app settings on various pages of the Backstage view



If all the page tabs don’t fit vertically in the left pane because of the window size or screen resolution, “More” appears at the bottom of the left pane. Selecting the More button displays a menu of the hidden page tabs.


[image: The More menu expanded from the left pane of the Backstage view of Word.]

Accessing hidden pages in Backstage view





Collaboration tools

If you’re using the Office apps through an Office 365 license, the Comments and Share buttons appear below the window-management commands, at the right end of the ribbon.


[image: Images]

The available collaboration tools vary by file storage location



The Comments button opens the Comments pane, in which you can easily create, review, respond to, and manage comments. The Share button makes it easy to quickly share a link to, or a copy of, the file.



Status bar

Across the bottom of the app window, the status bar displays information about the current file and provides access to certain app functions. You can choose the statistics and tools that appear on the status bar. Some items, such as Document Updates Available, appear on the status bar only when that condition is true.


[image: The left end of the Word status bar, displaying the Page Number, Word Count, Spelling and Grammar Check, Macro Recording, and Accessibility Checker controls.]

The left end of the Word status bar displays document information and tools



At the right end of the status bar are the View Shortcuts toolbar, the Zoom slider, and the Zoom Level button. These tools provide you with convenient methods for adjusting the display of file content.


[image: The right end of the Word status bar, displaying the Focus Mode, Read Mode, Print Layout, and Web Layout buttons, the Zoom Slider, and the Zoom control.]

Change the on-screen display of file content from the right end of the status bar




[image: Images] See Also

On a touchscreen device, the appearance of the buttons on the View Shortcuts toolbar changes depending on whether you’re in Mouse mode or Touch mode. For more information, see the next section, “Work with the ribbon and status bar.” For information about changing the file content view, see “Display different views of files” in Chapter 2, “Create and manage files.”






Work with the ribbon and status bar

The goal of the ribbon is to make working with file content as intuitive as possible. The ribbon is dynamic, meaning that as its width changes, its buttons adapt to the available space. As a result, a button might be large or small, it might or might not have a label, or it might even change to an entry in a list.

For example, when sufficient horizontal space is available, the buttons on the References tab of the Word app window are spread out, and you can review the commands available in each group.


[image: The Insert tab of the ribbon in Word at 1600 pixels wide.]

At 1600 pixels wide, all button labels are visible



If you make the app window narrower (and decrease the horizontal space available to the ribbon), small button labels disappear, and entire groups of buttons might hide under one button that represents the entire group. Selecting the group button displays a list of the commands available in that group.


[image: The Insert tab of the ribbon in Word at 1200 pixels wide.]

At 1200 pixels wide, command labels disappear, and groups collapse under buttons



When the ribbon becomes too narrow to display all the groups, a scroll arrow appears at its right end. Selecting the scroll arrow displays the hidden groups.


[image: The Insert tab of the ribbon in Word at 900 pixels wide.]

In narrow windows, scroll to display additional group buttons



The width of the ribbon depends on these three factors:


	App window width Maximizing the app window provides the most space for the ribbon.


	Screen resolution Screen resolution is the size of your screen display expressed as pixels wide × pixels high. The greater the screen resolution, the greater the amount of information that will fit on one screen. Your screen resolution options are dependent on the display adapter installed in your computer, and on your monitor. Common screen resolutions range from 800 × 600 to 2560 × 1440 (and some are larger). The greater the number of pixels wide (the first number), the greater the number of buttons that can be shown on the ribbon.


	The magnification of your screen display If you change the screen magnification setting in Windows, text and user interface elements are larger and therefore more legible, but fewer elements fit on the screen.




You can hide the ribbon completely if you don’t need access to any of its buttons, or you can hide it so that only its tabs are visible. (This is a good way to gain vertical space when working on a smaller screen.) Then you can temporarily redisplay the ribbon to select a button, or permanently redisplay it if you need to select several buttons.

If you’re working on a touchscreen device, you can turn on Touch mode, which provides more space between buttons on the ribbon and status bar. (It doesn’t affect the layout of dialogs or panes.) The extra space is intended to lessen the possibility of accidentally tapping the wrong button with your finger. The same commands are available in Touch mode, but they’re sometimes hidden under group buttons.


[image: Images]

Touch spacing provides more room between ribbon, Navigation pane, and status bar elements




Adapt procedures for your environment

This book contains many images of user interface (UI) elements (such as the ribbons and the app windows) that you’ll work with while performing tasks in Word, Excel, PowerPoint, or Outlook on a Windows computer. Depending on your operating system, screen resolution, or app window width, the app window ribbons on your screen might look different from those shown in this book. As a result, exercise instructions that involve the ribbon might require a little adaptation.

Simple procedural instructions use this format:


	On the Insert tab, in the Illustrations group, select the Chart button.




If the command is in a list, instructions use this format:


	On the Home tab, in the Editing group, select the Find arrow and then, in the Find list, select Go To.




A procedure that has multiple simple methods of completion uses this format:


	On the Quick Access Toolbar, select Save.


	In the left pane of the Backstage view, select Save.


	Press Ctrl+S.




If differences between your display settings and ours cause a button to appear differently on your screen than it does in this book, you can easily adapt the steps to locate the command. First select the specified tab, and then locate the specified group. If a group has been collapsed into a group list or under a group button, select the list or button to display the group’s commands. If you can’t immediately identify the button you want, point to likely candidates to display their names in ScreenTips.

Multistep procedural instructions use this format:


	To select the paragraph that you want to format in columns, triple-click the paragraph.


	On the Layout tab, in the Page Setup group, select the Columns button to display a menu of column layout options.


	On the Columns menu, select Three.




On subsequent instances of instructions that require you to follow the same process, the instructions might be simplified in this format because the working location has already been established:


	Select the paragraph that you want to format in columns.


	On the Columns menu, select Three.




The instructions in this book assume that you’re interacting with on-screen elements on your computer by selecting or clicking them with a mouse, or on a touchpad or other hardware device. If you’re using a different method—for example, if your computer has a touchscreen interface and you’re tapping the screen (with your finger or a stylus)—substitute the applicable tapping action when the book directs you to select a user interface element.

Instructions in this book refer to user interface elements that you select or tap on the screen as buttons, and to physical buttons that you press on a keyboard as keys, to conform to the standard terminology used in documentation for these products.

When the instructions tell you to enter information, you can do so by typing on a connected external keyboard, tapping an on-screen keyboard, or even speaking aloud, depending on your computer setup and your personal preferences.


You can switch between Touch mode and Mouse mode (the standard desktop app user interface) from the Quick Access Toolbar. Switching any one of the primary Office apps (Access, Excel, Outlook, PowerPoint, or Word) to Touch mode or Mouse mode effects the change in all of them.

To maximize the app window


	Select the Maximize button.


	Double-click the title bar.


	Drag the borders of a non-maximized window.


	Drag the window to the top of the screen. (When the pointer touches the top of the screen, an outline indicates the size the window will be when the pointer is released.)




To change the screen resolution


	Do either of the following to open the Display pane of the System settings page:


	Right-click or long-press (tap and hold) the Windows desktop, and then select Display settings.


	Enter screen resolution in Windows Search, and then in the search results, select Change the resolution of the display.





	In the Display pane, in the Resolution list, select the screen resolution you want. Windows displays a preview of the selected screen resolution.


	If you like the change, select Keep changes in the message box that appears. If you don’t, select Revert or wait for the screen resolution to automatically revert to the previous setting.




To change the magnification


	Do either of the following to open the Display pane of the System settings page:


	Right-click the Windows desktop, and then select Display settings.


	Enter screen resolution in Windows Search, and then in the search results, select Change the resolution of the display.





	In the Display pane, scroll to the Scale and layout area.


	In the Change the size of text, apps, and other items list, do either of the following:


	Select the standard scaling option you want.


	Select Custom scaling and enter a custom scaling size from 100 percent to 500 percent.







To completely hide the ribbon


	In the lower-right corner of the ribbon, select the Ribbon Display Options button.


[image: The Ribbon Display Options menu expanded from the lower-right corner of the ribbon. The Optimize Spacing Between Commands section contains the exclusive options Mouse Spacing and Touch Spacing. The Show Ribbon section contains the exclusive options Full-Screen Mode, Show Tabs Only, and Always Show Ribbon. The Show Quick Access Toolbar command is at the bottom of the menu.]

The new full-screen mode provides the largest work area




	On the Ribbon Display Options menu, select Full-screen mode.





[image: Images] Tip

Select the ellipsis (…) near the upper-right corner of the full-screen app window to temporarily redisplay the ribbon, then select the Ribbon Display Options button and either Show Tabs Only or Always Show Ribbon to restore it.



To display only the ribbon tabs


	Double-click any tab name.


	In the lower-right corner of the ribbon, select the Ribbon Display Options button, and then select Show tabs only.


	Press Ctrl+F1.




To temporarily redisplay the ribbon


	Select any tab to display the tab until you select a command or click away from the ribbon.




To permanently redisplay the ribbon


	Double-click any tab name.


	Select any tab name, then in the lower-right corner of the ribbon, select the Ribbon Display Options button, and then select Always show Ribbon.


	Press Ctrl+F1.




To optimize the ribbon for touch interaction


	In the lower-right corner of the ribbon, select the Ribbon Display Options button, and then select Touch spacing.




To specify the items that appear on the status bar


	Right-click the status bar to display the Customize Status Bar menu.


[image: The Customize Status Bar menu for the Word status bar. Twenty-seven tools are available in seven groups.]

A check mark indicates each active status bar tool




	Click to activate or deactivate a status bar indicator or tool. The change is implemented immediately. The menu remains open to permit multiple selections.


	When you finish, click away from the menu to close it.







Discover new features

To go along with the name change from Office 365, many new features have been incorporated into the Microsoft 365 apps since the previous edition of this book. These warrant special attention in this chapter because they might fall outside the range of the content that was selected from the individual Word, Excel, PowerPoint, and Outlook Step by Step books for this compilation.


	The user interface does not display the Quick Access Toolbar by default. You can display it above or below the ribbon and add controls to it from the Customize Quick Access Toolbar menu, the Options dialog, or the ribbon, just as before.


	The Save command that was previously on the Quick Access Toolbar is now located at the left end of the title bar, along with the new AutoSave toggle. AutoSave is available only for files that are stored in the Microsoft cloud (in OneDrive or SharePoint).


	Also for cloud-stored files, you can rename or move a file while editing it, display its version history, and display, compare, and restore previous file versions from the title bar.


	In the center of the title bar, the Microsoft Search feature provides quick access to file content, app features, Help articles, and previously edited files. You can type a search term into the search box or select the microphone and then speak the search term.


	If you prefer speaking to typing, you can enter content into files by using the Dictate feature that’s available from the Home tab in Word documents, PowerPoint presentations, and Outlook message composition windows.


[image: images] Important

The audio search and dictation features require an audio card and an audio input device such as a built-in, headset, or USB-connected microphone.




	When you dock multiple panes on the right side of the app window—for example the Styles pane and the Alt Text pane, or even the Navigation pane—they arrange themselves on tabs, taking up only the space of one pane.


	You can increase the space between commands on the ribbon, menus, and the status bar to make it easier to access the right command when working on a touch-enabled device such as a tablet.


	Many accessibility features have been incorporated into the apps.


	The Accessibility Checker runs by default in the background.


	An Accessibility command on the status bar provides immediate feedback as to the accessibility of your document, presentation, or workbook and easy access to the Accessibility Pane, which displays the Accessibility Checker’s findings and suggested solutions.


	Alt text is automatically added to pictures that you insert into documents, presentations, and email messages. (You can, and should, review and refine the automatically generated alt text.)


	Accessibility tools are available from a new Accessibility group on the Review tab of each app. From here you have quick access to app-specific accessibility-related options in the Options dialog.





[image: Images] Important

Accessibility is frequently associated with the availability of content to people with disabilities such as limited vision or hearing loss, or to people who use assistive technologies such as screen readers, screen magnifiers, or braille displays. In fact, a website or document that is designed for accessibility is easier for all people to navigate and comprehend, regardless of the method they use to access the content.




	The ribbon display options now support the display of the whole ribbon, only the tabs, or a full-screen display that entirely hides the ribbon.


	In Word, a new Focus mode displays document content against a black background with none of the app interface visible. You can turn on Focus mode from the status bar or View tab and turn it off by pressing the Esc key.


	An extensive library of professional-quality images, icons, and (in PowerPoint) videos is available from the Insert Pictures menu. The Online Pictures feature provides easy access to thousands of Creative Commons–licensed images that you can browse by category or locate by search term.


	The Help tab provides access to find information and training resources, contact Microsoft Support, provide feedback about features you like and don’t like, and suggest features you’d like to see in future releases. You can also access the release notes for each recent release of the app.


	In Excel:


	A new Navigation Pane provides easy access to tables, charts, and other elements. This is particularly helpful in workbooks that include a lot of worksheets.


	The Analyze Data tool provides powerful analysis capabilities for the data you save in workbooks.


	From the Help tab, you can drop in on or participate in Excel community groups and read blog posts from the product-development team.







Each new release of Office has new features, fixes, or just improvements. As with the certainty of death and taxes, the one thing we know is that we don’t know what we don’t know! Most people who use a new version of a product try to accomplish things the same way they did in the old version, but this might be more work than necessary. If you’re a seasoned Office app user, review the ribbon tabs, Backstage view pages, and Options dialog for any new or modified features that will simplify the tasks you perform and support your productivity.



Change Office and app options

You access app settings from the Backstage view—specifically, from the Account page and the Options dialog.


Manage account information

The Account page of the Backstage view in each Office app (other than Outlook, in which it’s called the Office Account page) displays information specific to your installation of the app. This information includes:


	Your Microsoft account and links to manage it.


	The current app window background and theme.


	Storage locations and services (such as OneDrive and SharePoint) that you’ve connected Office to.


	Your subscription information and links to manage the subscription, if you have Office through an Office 365 subscription.


	The installed app version and build number, update options, and links to information about the app and recent updates.





[image: The Account page of Word, displaying user information, Office background and theme options, connected services, product information, links to manage the account associated with the product or to change the license being used on the active computer, and the Office Updates, About (the product), and What's New buttons.]

Account information in Word




Microsoft account options

If you use Microsoft 365, Office 365, Skype, OneDrive, or Xbox Live, or have an Outlook.com or Hotmail.com email address, you already have a Microsoft account. (Microsoft account credentials are also used by many non-Microsoft products and websites.) If you don’t already have a Microsoft account, you can register any existing account as a Microsoft account, sign up for a free Outlook.com or Hotmail.com account and register that as a Microsoft account, or create an alias for an Outlook.com account and register the alias.



[image: Images] Tip

Many apps and websites authenticate transactions by using Microsoft account credentials. For that reason, it’s a good idea to register a personal account that you control, rather than a business account that your employer controls, as your Microsoft account. That way, you won’t risk losing access if you leave the company.



You can personalize the appearance of your Office app windows by choosing an Office theme. There are five Office theme options:


	Dark Gray Displays the title bar and ribbon tabs in dark gray, and the ribbon commands, status bar, and Backstage view in light gray.


	Black Displays the title bar, ribbon tabs, ribbon commands, and status bar in black and dark gray.


	White Displays the title bar, ribbon tabs, and ribbon commands in white, and the status bar in the app-specific color.


	Use System Setting Coordinates the Office app window settings with the Windows theme settings.


	Colorful Displays the title bar and ribbon tabs in a color specific to the app (such as blue for Word and green for Excel), and the ribbon commands, status bar, and Backstage view in light gray.




You can also choose an Office background, which is a subtle design that appears in the title bar area of the Backstage view. (In previous versions of the Office apps, it appeared in the title bar of the app window, regardless of the active tab.) There are 14 different backgrounds to choose from—Calligraphy, Circles and Stripes, Circuit, Clouds, Doodle Circles, Doodle Diamonds, Geometry, Lunchbox, School Supplies, Spring, Stars, Straws, Tree Rings, and Underwater. If you prefer to not clutter up the title bar, you can choose to not have a background.

From the Connected Services area of the page, you can connect Office to SharePoint sites and OneDrive storage locations to access the files you store there. You must already have an account with one of these services to connect Office to it.

Until you connect to storage locations, they aren’t available to you from within Word. For example, when inserting a picture onto a page, you will have the option to insert a locally stored picture or to search online for a picture. After you connect to your SharePoint or OneDrive accounts, you can also insert pictures stored in those locations.

The changes you make on the Account page apply to all the Office apps installed on all the computers associated with your account. For example, changing the Office background in Word on one computer also changes it in Outlook on any other computer on which you’ve associated Office with the same account.

To display your Office account settings


	Start Word, Excel, PowerPoint, or Outlook.


	Select the File tab to display the Backstage view of the app, and then do either of the following:


	In Word, Excel, or PowerPoint, select Account.


	In Outlook, select Office Account.







To manage your Microsoft account connection


	Display the Account or Office Account page of the Backstage view.


	In the User Information area, select Change photo, About me, Sign out, or Switch account to begin the selected process.




To change the app window background for all Office apps


	Display the Account or Office Account page of the Backstage view.


	In the Office Background list, point to any background to display a live preview in the app window, and then select the background you want.




To change the app window color scheme for all Office apps


	Display the Account or Office Account page of the Backstage view.


	In the Office Theme list, select Colorful, Dark Gray, Black, or White.




To connect to a cloud storage location


	Display the Account or Office Account page of the Backstage view.


	At the bottom of the Connected Services area, select Add a service, Storage, and then the specific service you want to add.


[image: The Add A Service menu expanded to display the available storage options, OneDrive and OneDrive For Business.]

Connect to personal and business cloud storage locations






To manage your Office 365 subscription


	Display the Account or Office Account page of the Backstage view.


	In the Product Information area, select Manage Account to display the sign-in page for your Office 365 management interface.


	Provide your account credentials and sign in to access your options.




To manage Office updates


	Display the Account or Office Account page of the Backstage view.


	Select the Update Options button, and then select the action you want to take.


[image: The Update Options menu displaying the Update Now, Disable Updates, View Updates, and About Updates buttons.]

You can install available updates from the Backstage view before the automatic installation occurs








Manage app options

Selecting Options in the left pane of the Backstage view opens the app-specific Options dialog. Every Options dialog has a General tab where you can set user-specific information that is shared among the Office apps (some of this is the same information you can configure in the Backstage view) and configure high-level app-specific options.


[image: The General page of the Excel Options dialog with options for the user interface, new workbooks, personalizing Office, privacy, LinkedIn features, and startup behavior.]

You can customize the behavior of each app from its Options dialog



Each app’s Options dialog contains hundreds of settings specific to that app. For example, you can make the following useful changes:


	
In Word You can configure spelling and grammar-checking options including your writing style, change the default behavior when pasting content, and specify the view when opening an email attachment.


	In Excel You can change the default workbook font and number of worksheets, formula calculation and autocomplete options, error-checking rules, and the direction the cell selection moves when you press the Enter key.


	In PowerPoint You can turn on or off PowerPoint Designer suggestions and the automatic generation of alt text for pictures and configure the display of slideshow options such as the toolbar and blank ending slide.


	In Outlook You can configure the default appearance of outgoing messages, automatically create meetings as Teams meetings, customize your calendar so that the working days reflect your schedule, add the holidays of any country or region to your calendar, and store your Outlook settings in the cloud so they carry over to other computers on which you use Outlook.




There are also settings specific to the file you’re working in. For example, you can hide spelling or grammar errors in a specific document or specify the image compression level for a document or presentation to increase image quality or decrease file size.

Some settings are available in all the app Options dialogs, including the following:


	Turn off the Mini Toolbar, which hosts common formatting commands and appears by default when you select content.


	Turn off the Live Preview feature if you find it distracting to have document formatting change when the pointer passes over a formatting command.


	Minimize or turn off the display of ScreenTips when you point to buttons.


	Specify the user name and initials you want to accompany your comments and tracked changes, and override the display of information from the account associated with your installation of Office.


	Turn off the Home pages for Word, Excel, and PowerPoint individually. When the Home page is turned off, starting the app without opening a specific file automatically creates a new, blank file.




After you work with an app for a while, you might want to refine more settings to tailor the app to the way you work. Knowing what options are available in the Options dialog is helpful in determining the changes that you can make to the app so that you can work most efficiently.


[image: Images] Tip

Although detailed coverage of each app’s Options dialog is beyond the scope of this book, extensive information is available in the Step by Step book for each app, including Microsoft Word Step by Step (Office 2021 and Microsoft 365), by Joan Lambert (Microsoft Press, 2022), and Microsoft Excel Step by Step (Office 2021 and Microsoft 365), by Joan Lambert (Microsoft Press, 2021).




[image: Images] Tip

Two app elements you can customize from the Options dialog are the Quick Access Toolbar and the ribbon. For information, see “Display and Customize the Quick Access Toolbar” and “Customize the ribbon” later in this chapter.



To open an app-specific Options dialog


	Select the File tab to display the Backstage view.


	In the left pane, select Options.




To enable or disable the Mini Toolbar


	Open the app-specific Options dialog.


	On the General page, in the User Interface options area, select or clear the Show Mini Toolbar on selection checkbox. Then select OK.




To enable or disable the Live Preview feature


	Open the app-specific Options dialog.


	On the General page, in the User Interface options area, select or clear the Enable Live Preview checkbox. Then select OK.




To control the display of ScreenTips


	Open the app-specific Options dialog.


	On the General page, in the User Interface options area, display the ScreenTip style list, and then select any of the following:


	Show feature descriptions in ScreenTips


	Don’t show feature descriptions in ScreenTips


	Don’t show ScreenTips





	In the Options dialog, select OK.




To change the user identification that appears in comments and tracked changes


[image: Images] Important

The User Name and Initials settings are shared by all the Office apps, so changing them in any one app changes them in all the apps.




	Open the app-specific Options dialog.


	On the General page, in the Personalize your copy of Microsoft Office area, do the following:


	In the User name and Initials boxes, enter the information you want to use.


	Select the Always use these values regardless of sign in to Office checkbox.





	In the Options dialog, select OK.




To enable or disable the Home screen for the app


	Open the app-specific Options dialog.


	On the General page, in the Start up options area, select or clear the Show the Start screen when this application starts checkbox. Then select OK.







Display and customize the Quick Access Toolbar

The Quick Access Toolbar is a customizable toolbar that you can display above or below the ribbon. If you regularly use a few commands that are scattered on various tabs of the ribbon and you don’t want to switch between tabs to access the commands, you might want to add them to the Quick Access Toolbar so that they’re always available to you.

You can configure a separate Quick Access Toolbar for each Office app. By default, the Quick Access Toolbar is available in all files that you open in that app. You can also create a Quick Access Toolbar that is specific to a file and travels with it, so the commands are available to anyone who opens that file.

You can add commands to the Quick Access Toolbar from a menu on the toolbar, directly from the ribbon, or from the Quick Access Toolbar page of the app-specific Options dialog.


[image: The Quick Access Toolbar page of the Word Options dialog box presents available commands on the left and the current Quick Access Toolbar configuration on the right.]

The Quick Access Toolbar is the most convenient command organization option




[image: Images] Tip

You can display a list of commands that do not appear on the ribbon by selecting Commands Not In The Ribbon in the Choose Commands From list on the Quick Access Toolbar or on the Customize Ribbon page of the app-specific Options dialog.



You can customize the Quick Access Toolbar in the following ways:


	Define a custom Quick Access Toolbar for all files opened in the app or for a specific file.


	Add any command from any group of any tab, including tool tabs, to the toolbar.


	Display a separator between different types of buttons.


	Move commands around on the toolbar until they are in the order you want.


	Reset everything back to the default Quick Access Toolbar configuration.




After you add commands to the Quick Access Toolbar, you can reorganize them and divide them into groups to simplify the process of locating the command you want.

As you add commands to the Quick Access Toolbar, it expands to accommodate them. If you add a lot of commands, it might become difficult to view the text in the title bar, or all the commands on the Quick Access Toolbar might not be visible, defeating the purpose of adding them. To resolve this problem and also position the Quick Access Toolbar closer to the file content, you can move the Quick Access Toolbar below the ribbon.

To display the Quick Access Toolbar


	Right-click any ribbon tab and then select Show Quick Access Toolbar.


	Right-click any command on the ribbon, and then select Show Quick Access Toolbar.


	In the left pane of the Options dialog, select Quick Access Toolbar. On the Customize the Quick Access Toolbar page, select the Show Quick Access Toolbar checkbox, and then select OK.




To add a popular command to the Quick Access Toolbar


	At the right end of the Quick Access Toolbar, select the Customize Quick Access Toolbar button. On the menu of commonly used commands, select a command you want to add.


[image: The Customize Quick Access Toolbar menu expanded from the right end of the Quick Access Toolbar.]

Commonly used commands are available from the menu






To add a command to the Quick Access Toolbar from the ribbon


	Right-click a command on the ribbon, and then select Add to Quick Access Toolbar. You can add any type of command this way; you can even add a dropdown list of options or gallery of thumbnails.




To display the Quick Access Toolbar page of the Options dialog


	At the right end of the Quick Access Toolbar, select the Customize Quick Access Toolbar button, and then select More Commands.


	Select the File tab and then, in the left pane of the Backstage view, select Options. In the left pane of the Options dialog, select Quick Access Toolbar.


	Right-click any ribbon tab or empty area of the ribbon, and then select Customize Quick Access Toolbar.




To add a command to the Quick Access Toolbar from the Options dialog


	Display the Quick Access Toolbar page of the Options dialog.


	In the Choose commands from list, select the tab the command appears on, or select Popular Commands, Commands Not in the Ribbon, All Commands, or Macros.


	In the left list, locate and select the command you want to add to the Quick Access Toolbar. Then select the Add button.


	Make any other changes, and then select OK in the Options dialog.




To move the Quick Access Toolbar


	At the right end of the Quick Access Toolbar, select the Customize Quick Access Toolbar button, and then select Show Below the Ribbon or Show Above the Ribbon.


	Display the Quick Access Toolbar page of the Options dialog. Below the Choose Commands From pane, select or clear the Show Quick Access Toolbar below the Ribbon checkbox.




To define a custom Quick Access Toolbar for a specific file


	Display the Quick Access Toolbar page of the Options dialog.


	In the Customize Quick Access Toolbar list (above the right pane) select For file name.


	Add the commands to the toolbar that you want to make available to anyone who edits the file, and then select OK. The app displays the file-specific Quick Access Toolbar to the right of the user’s own Quick Access Toolbar.





[image: Images] Tip

If a command is on a user’s Quick Access Toolbar and on a file-specific Quick Access Toolbar, it will be shown in both toolbars.



To display a separator on the Quick Access Toolbar


	Display the Quick Access Toolbar page of the Options dialog.


	In the right pane, select the command after which you want to insert the separator.


	Do either of the following:


	In the left pane, double-click <Separator>.


	Select <Separator> in the left pane, and then select the Add button.





	Make any other changes you want, and then select OK.




To move buttons on the Quick Access Toolbar


	Display the Quick Access Toolbar page of the Options dialog.


	In the right pane, select the button you want to move. Then select the Move Up or Move Down arrow until the button reaches the position you want.




To reset the Quick Access Toolbar to its default configuration


	Display the Quick Access Toolbar page of the Options dialog.


	In the lower-right corner of the page, select Reset, and then select either of the following:


	Reset only Quick Access Toolbar


	Reset all customizations





	In the Microsoft Office message box verifying the change, select Yes.





[image: Images] Important

Resetting the Quick Access Toolbar does not change its location. You must manually move the Quick Access Toolbar by using either of the procedures described earlier.





Customize the ribbon

The ribbon was designed to make all the commonly used commands visible so that people can more easily discover the full potential of an Office app. But many people use the same app to perform the same set of tasks all the time, and for them, seeing buttons (or even entire groups of buttons) that they never use is just another form of clutter.

Would you prefer to display fewer commands, not more? Or would you prefer to display more specialized groups of commands? Well, you can. From the Customize Ribbon page of an app’s Options dialog, you can control the tabs that appear on the ribbon, and the groups that appear on the tabs.


[image: The Customize Ribbon page of the Excel Options dialog presents available commands on the left and the current ribbon configuration on the right.]

You can hide and display individual ribbon tabs



On this page, you can customize the ribbon in the following ways:


	Hide an entire tab.


	
Remove a group of commands from a tab. (The group is not removed from the app, only from the tab.)


	Move or copy a group of commands to another tab.


	Create a custom group on any tab and then add commands to it. (You cannot add commands to a predefined group.)


	Create a custom tab. For example, you might want to do this if you use only a few commands from each tab and you find it inefficient to flip between them.




Don’t be afraid to experiment with the ribbon to come up with the configuration that best suits the way you work. If at any point you find that your new ribbon is harder to work with rather than easier, you can easily reset everything back to the default configuration.


[image: Images] Important

Although customizing the default ribbon content might seem like a great way of making the app yours, it isn’t recommended that you do so. A great deal of research has been done about the way that people use the commands in each app, and the ribbon has been organized to reflect the results of that research. If you modify the default ribbon settings, you might end up inadvertently hiding or moving commands that you need. Instead, consider the Quick Access Toolbar as the command area that you customize and make your own. If you add all the commands you use frequently to the Quick Access Toolbar, you can hide the ribbon and have extra vertical space for document display (this is very convenient when working on a smaller device). Or, if you really want to customize the ribbon, do so by gathering your most frequently used commands on a custom tab, and leave the others alone.



To display the Customize Ribbon page of the Options dialog


	Display the Options dialog, and in the left pane, select Customize Ribbon.


	Right-click any ribbon tab or empty area of the ribbon, and then select Customize the Ribbon.




To permit or prevent the display of a tab


	Display the Customize Ribbon page of the Options dialog.


	In the Customize the Ribbon list, select the tab set you want to manage:


	All Tabs


	Main Tabs


	Tool Tabs





	In the right pane, select or clear the checkbox of any tab other than the File tab. (You can’t hide the File tab.)




To remove a group of commands from a tab


	Display the Customize Ribbon page of the Options dialog.


	In the Customize the Ribbon list, select the tab set you want to manage.


	In the right pane, select the Expand button (+) to the left of the tab you want to modify.


	Select the group you want to remove, and then in the center pane, select the Remove button.




To create a custom tab


	Display the Customize Ribbon page of the Options dialog.


	On the Customize Ribbon page, select the New Tab button to insert a new custom tab below the active tab in the right pane. The new tab includes an empty custom group.


[image: The right pane of the Customize Ribbon page of the Excel Options dialog after inserting a custom tab. The custom tab, named New Tab, automatically includes one custom group, named New Group.]

Creating a new tab and group






To rename a custom tab


	Select the custom tab, and then select the Rename button.


	In the Rename dialog, replace the existing tab name with the tab name you want, and then select OK.




To rename a custom group


	Select the custom group, and then select the Rename button to open a Rename dialog that includes hundreds of symbol options.


[image: The Rename dialog displaying the first 120 symbols. A vertical scroll bar indicates that more are available. Below the symbol section is a Display Name box in which the user can edit the default group name, New Group.]

You can assign an icon to appear when the group is minimized




	In the Rename dialog, change the display name, select the symbol you want to display when the ribbon is too narrow to display the group’s commands, and then select OK.




To create a custom group


	Display the Customize Ribbon page of the Options dialog.


	On the Customize Ribbon page, in the right pane, select the tab you want to add the group to. Then select the New Group button to add an empty custom group.
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